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شناخت و به کارگیری سبک‌ها و مکاتب هنری در طراحی فضا   

ابزار و تجهيزات: مداد رنگی تک‌رنگ مانند آبی یا قرمز و مداد اتود با نوک نرم و 
خط‌کش و لوازم مورد احتیاج می باشد.

رئالیسم  و  کوبیسم  سبک  مانند  نقاشی  مختلف  سبک  نوع  دو  ابتدا  اول:  گام   
انتخاب شود.

واحد يادگيري    4     :  ایجاد سبک بصری  
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 گام دوم: سپس یک صحنه از یک پويانمايي که فضاسازی در آن صحنه بارزتر 
است انتخاب كنند. برای انتخاب یک صحنه از پويانمايي می‌توانند آن را در رايانه 
پخش کرده و با متوقف كردن آن پويانمايي از آن صحنه موردنظر عکس گرفته و 

آن را برای تمرین آماده كنند.

را  آن صحنه  انتخابی،  دو سبک  از  الهام  با  را  انتخاب شده  تصاوير   گام سوم: 
از  بیاورند. لازم است هنرجويان ویژگی‌های کلی  رئالیسم در  و  به سبک کوبیسم 
از  الهام  و  تغییرات صحنه  تا در  را مطالعه كنند  انتخاب می‌کنند  سبک‌هایی که 

سبک موردنظر با دقت بیشتری عمل كنند. 

پويانمايي سینمایی زوتوپیا

تصویرانتخابی از یک فیلم پویانماییتصویرانتخابی از یک سبک هنری

فضاسازی نهایی همان تصویر انتخاب شده پویانمایی با 
الهام از سبک هنری انتخاب شده
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که نکته باشد  گونه‌ای  به  باید  پويانمايي  در  انتخاب سبک  که  است  توضیح  به  لازم 
قابلیت تکثیر در دقیقه های بالا و به صورت گروهی را داشته باشد و به گونه ای 
نتوان عین آن را تکثیر  برای فریم بعدی  نباشد که فقط یک فریم کار شود و 

نمود.

 گام چهارم:  از روی دو تصویر انتخابی سبک ها، هنرجويان با مداد طراحی كنند.
  گام پنجم: سپس ویژگی‌های این سبک را بیان كنند. مثلًا برای سبک کوبیسم 
استفاده  بیشتر  و صاف  تیز  و خطوط  از شکل‌های هندسی  که  بگویند  می توانند 

شده است.
  گام ششم: پس از آن یک فضا با الهام از آن سبک ها طراحی كنند. دقت كنند 
که این طراحی فضا برای استفاده در پويانمايي می باشد و باید به گونه ای از سبک 
الهام گرفته شود که از بابت بصری زیبا و در عین حال شخصیت ها در آن محیط 

گم و ناپیدا نباشند.
 گام هفتم: در گام بعدی برای بخش مکتب های هنری از هنرجويان بخواهید 
تصویری از یک مکتب هنری مانند مکتب نقاشی قهوه خانه‌ای تهیه نمایند سپس 

دربارة ویژگی‌های بارز آن مکتب، مطالبی را گردآوري كنند.
  گام هشتم: پس از آن با استفاده از مداد طراحی شروع به کپی‌برداری و مطالعة 
درباره  ما  کتاب  موضوع  چون  که  باشند  داشته  توجه  كنند.  نقاشی  آن  تصویری 

فضاسازی می باشد؛ مشخصات بازر تصاوير انتخابي فضاسازی و محیط باشد.
 گام نهم: پس از کپی‌برداری به وسیله طراحی اكنون از هنرجويان بخواهید یک 
فضای جدید با الهام از آن مکتب انتخاب شده طراحی كنند. در این بخش نیازی 

به رنگ‌آمیزی نیست و صرفاً طراحی کفایت می‌کند.
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نوع  این  تولید شده  نمونه های  از 
پويانمايي‌ها که تحت تأثیر مکتب 
و سبک های هنری بوده می توان 
به پويانمايي های کوتاه جشنواره ای 
مانند نمونه های تولید شده توسط 
الکساندر  به نام  روسی  هنرمند 
و  رئالیستی  سبک  به  که  پتروف 

نقاشی رنگ روغن اشاره کرد.

پيرمرد و دريا، الکساندر پتروف
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به کارگیری تکنیک های تصویرسازی در طراحی فضا  
در این بخش در کتاب اصلي هنرجويان توضیحات کافی وجود دارد و نیاز هست 

این بخش با فعالیت عملی بیشتر و بهتر قابل درک برای هنرجويان باشد.
  گام اول: ابتدا یک کتاب داستان مربوط به هر گروه سنی که در آن از تصویرگری 

استفاده شده است را انتخاب كنند.
  گام دوم: سپس دربارة ویژگی‌های تصویرگری کتاب و تکنیک اجرایی آن به 

همراه هنرجويان به  بحث و بررسی پرداخته شود.
 گام سوم: از آنها بخواهید از روی تصویر انتخاب شده با مداد طرحی، کپی برداری 

و طراحی كنند.

نکته آن  دیزاین  و  ساختاری  ویژگی‌های  طراحی  هنگام  در  هنرجويان  است  لازم 
تصويرگری را هم بیان كنند.

 گام چهارم: پس از آن هنرجويان 
با الهام از سبک تصويربرداری انتخابی 

یک فضای دلخواه طراحی كنند.
یک  بعدی  بخش  در  پنجم:      گام 
بالتازار  پرفسور  مانند  پويانمايي 
با  همراه  را  چنینی  این  مشابه  یا 
هنرجويان مورد بررسی و آنالیز قرار 

دهید.
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پویانمایی پروفسور بالتازار
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 گام دوم: پس از آن، از روی آن با کپی برداری با مداد طراحی كنند و نکات مهم 
و دریافت‌های خود را از فرم ها و اصول آن کاریکاتور، در کلاس بیان كنند. در پایان 
هنرجويان آن چهره را تبدیل به یک فضای پويانمايی كنند. این کار می تواند با 

اضافه کردن درخت و دیوار و سایر موارد انجام گیرد. 

 روش دوم

  گام اول: در مرحلة دوم ابتدا دو تصویر )به صورت عکس( از یک شهر بزرگ 
برای بررسی  آزاد  ابتدا به صورت  آنها  از روی  و تپه ای کوچک تهیه كنند. سپس 
بیشتر فرم و ویژگی‌های آن تصاویر طراحی كنند. پس از آن از هنرجويان بخواهید 
که شهر بزرگ را در روی تپه با روی هم قرار دادن و جابه‌جایی قرار دهد در واقع 
ما هنرجو را به سمتی وادار کردیم که با استفاده از اغراق بتواند یک شهر بزرگ را 

روی یک تپه کوچک قرار دهد.

اغراق در خلق فضا 

  روش اول

 گام اول: ابتدا هنرجويان یک تصویر از کاریکاتور چهره‌ای را تهیه كنند. فرقی 
نمی کند که مربوط به چه شخص یا آثار چه کسی باشد اما نکته ای که بهتر است 

مدنظر قرار دهند این است که کاریکاتوري حجمي باشد.
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یا  از پل  برای خلاقیت بیشتر هنرجو می تواند 
پله پله قرار دادن خانه ها روی هم استفاده نماید. 

ترکیب شهر و تپه
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ترکیب فضاهای دوبعدی وسه بعدی  
 گام اول: ابتدا عکس‌هایی از خانه یا محله تهیه كنند

 گام دوم: سپس از اینترنت یا از تصاویر آرشیوی خود تصاویری از پس‌زمينه‌های 
دوبعدی مانند تصاویر کوه یا درختان و غیره تهیه كنند.

  گام سوم: سپس در فتوشاپ و با استفاده از لایه‌بندی، تصویر عکس محیط را 
با تصاویر دوبعدی پويانمايی ترکیب كرده و به یک فضای جدید ترکیبی برسند.
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 در ترکیب فضاهای سه‌بعدی با دوبعدی شما می توانید از ترکیب فضای پويانمايی 
با فیلم رئال یا ترکیب فضای دوبعدی با پويانمايي های عروسکی و نیز ترکیب فضای 

دوبعدی با پويانمايي‌های سه‌بعدی استفاده نمایید.

 این نوع ترکیب فضاهای دوبعدی با سه‌بعدی به دلایل مختلفی مانند تکنیک نکته
در  صرفه‌جویی  دلایل  به  یا  فضاها  پردازش  مانند  فنی  دلایل  یا  شده  انتخاب 
)ترکیب  نجار  و  وروجک  پويانمايي  مانند  مثلًا  دارد.  کاربرد  و...  فضا  ساخت 
از نقاشی  با فیلم زنده( یا پويانمايي های عروسکی که در نماهای دور  دوبعدی 

برای پر کردن فضاها استفاده می‌گردد.

 روش سوم
از هنرجويان بخواهید از اسباب بازی های موجود در خانه خود مانند ماشین یا هر 
چیزی که می توانند و ترجیحاً اگر خانه یا ماشین و... باشد بهتر است. در محیطی 
که پس‌زمینه عکس سفید است عکاسی كنند. سپس فضای سفید آن را در رايانه 
پاک کرده و بعد یک تصویر پس‌زمينه دوبعدی مانند اتوبان، خیابان یا هر منظره ای 
که می‌شود هم تهیه كرده و سپس آن را در فضای پشت ماشین یا آن خانه جای 

دهند.

تأثیر سبک بصری در انتخاب نرم‌افزار برای اجرای فضا  
برای این بخش از هنرجويان بخواهید چند نوع فضای مختلف که در نرم‌افزارهای 
مختلف ایحاد شده است را گردآوری كنند و سپس دربارة نرم‌افزار استفاده شده 
توضیحاتی مانند ویژگی‌ها و کاربردهای آن بیان كنند. مثلًا یک فضای سه بعدی 
بررسی  این گونه می توان  را  مانند تری‌دی‌مکس کار شده است  نرم‌افزاری  با  که 

نمود: 
نرم‌افزار به کار رفته؛ سه‌بعدی به نام تری‌دی‌مکس و محصول کمپانی ... می باشد. 
امروزه در پويانمايي‌هایی که حرکات پیچیدة دوربین نیز مواردی مانند پروژه‌های 
سینمایی و ... کاربرد دارد. فضای ساخته شده در این نرم‌افزار قابلیت این را دارد 
که به وسیلة دوربین، چرخش کامل داشته و نیز از بافت گذاری‌های ایجاد رنگ و 

بافت استفاده کرد و .... 
چند نمونه از فضای تصویری نرم‌افزارهای مختلف مانند فتوشاپ، تری دی مکس 

و ...
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فصل سوم

اجرای رایانه ای فضای دوبعدی
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دانش‌افزايي   

تصاویر دیجیتال 
در صنعت عکاسی آنالوگ، تصاویر آنالوگ هستند یعنی طی یک فرایند شیمیایی بر 
روی کاغذ عکاسی ثبت می‌گردند و دیجیتال نیستند. این تصاویر به علت نور دادن به 
ریزدانه‌های )Grain( حساس به نور بر سطح کاغذ عکاسی در مرحلۀ ظهور عکس 
به وجود می آیند. در عکاسی دیجیتال این نقاط با پیکسل معادل سازی شده‌اند 
و در واقع نقطه یا Dot در فایل‌های دیجیتال قدری متفاوت با نقاط آنالوگ است. 
همان طور که می دانید تصاویر دیجیتال به طورکلی یا وکتور )VECTOR( هستند 
که بر مبنای معادلات ریاضی ترسیم می شوند و یا رستر)RASTER( هستند که 

ساختار پیکسلی دارند.
نقاط)Dot( در دنیای دیجیتال نمی توانند در ابعاد مختلف باشند و فقط تعدادشان 
در سطح تصویر بر مبنای یک معیار، مانند اینچ و یا سانتیمتر تعیین می گردند. 
اما در تصاویر آنالوگ به خاطر فرایند شیمیایی و حساسیت کاغذ عکاسی و فیلم 
عکاسی نقاط، اندازه های متفاوت دارند. نقاط در فایل‌های دیجیتال بنابر پیش فرض 
سیستم‌های خروجی تعریف می شوند. خروجی‌هایی مانند پرینترها1، پلیِت سِتر2ها 

و ایمیچ ستر3ها، پروژکشن‌ها و مانیتورها.

 Dot Per Inch 1ـ پرینترهای سوزنی )که معمولاً در بانک‌ها می‌بینید( خروجی تصویرشان به صورت
یا نقطه بر اینچ است. 

2ـ پلیت ستر: دستگاهی در صنعت چاپ در بخش لیتوگرافی که تصاویر دیجیتال را به صورت خطی 
Line per Inch خوانش نموده و با لیزر به شکل ترام‌های چاپ بر روی زینک ثبت می‌کنند.

3ـ ایمیج ستر: دستگاهی در صنعت چاپ که مانند پلیت ستر است اما تصاویر را به همان شکل 
بر روی تلق )فیلم لیت( ثبت می‌کند و سپس در دستگاهی دیگر مانند عکس آنالوگ، با فرایندی 
شیمیایی تصاویر را به صورت ترام‌های چاپ به روی زینک منتقل می‌کند. )برای آشنایی بیشتر 

اطلاعات صنعت لیتوگرافی را در اینترنت جستجو کنید(

واحد يادگيري    5     :  انتقال تصاوير، شناخت ابزار و امكانات اجرايي 
فضاي دوبعدي ديجيتال
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تصاویر می توانند به صورت نقطه )Dot(، پیکسل )Pixel(، و یا خط )Line( تعریف 
شوند. در مانیتورها صفحۀ LED به خاطر چیدمان شطرنجی لامپ های آن، همواره 
است  چهاروجهی1  که   Pixel پیکسل  به صورت  تصویر  و  دارد  شطرنجی  ساختار 
نمایش داده می شود. ولی هنگام نمایش آنها را متناسب با کاربرد و تعریف اولیه ای 
که برای فایل كرده ایم، نمایش می دهد. نکته کلیدی درک ساختار تصاویر در این 
است که درواقع نمایشگرها )صفحات LED( صرفاً تصاویر را به ما نشان می دهند و 
فایل‌ها در نرم افزار و یا ابزارهای ضبط تصاویر دیجیتال نظیر دوربین‌های دیجیتال 
و اسکنرها شکل می گیرند. مانیتور واسطی است تا قبل از ساخت یک فایل، با دیدن 

بر روی صفحۀ مانیتور نوع ساختار آن را تعیین نماییم. 

شکل  اما  می گردند  ضبط  سنسورها  روی  بر  چهاروجهی  غالب  در  امروزه  دیجیتال  تصاویر  1ـ 
چهار وجهی در حال مطالعه و بازنگری است. در آیندۀ نزدیک شاهد پیکسل هایی با اشکال چند 

وجهی خواهیم بود. )رجوع کنید به مطالعات در مورد CCDها و CMOSها در فضای مجازی(

انواع ساختار تصاویر دیجیتال برای سیستم‌های خروجی

مثال‌هایی برای تعیین ساختارهای تصاویر دیجیتال متناسب با دستگاه‌های 
خروجی

 PPI معمولاً برای دستگاه‌هایی که خروجی آنالوگ دارند استفاده می شود. مانند: 
پروژکشن‌ها،  عکاسی،  دوربین‌های  برای  همچنین  و  لیزری  و  رنگی  پرینترهای 

مانیتورها و تلویزیون‌ها
  DPI، معمولابًرای پرینترهای سوزنی استفاده می شود.

استفاده  لیتوگرافی  لیزری نظیر دستگاه‌های  برای خروجی های  LPI، معمولاً    
می شود.

نکته براساس  که  دراو(  کورل  نرم افزار  )مانند  نرم افزارهایی  در  وکتور  تصاویر  برای 
محاسبات ریاضی تصاویر را خلق می کنند، بایستی LPI ،DPI و یا PPI، تعریف 
نمود. البته تعیین ساختار شکل گیری تصویر در نرم افزارهای وکتور، متناسب با 

نوع استفاده از خروجی مورد نظر متفاوت است.
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جلوهای بیت مپ)Pixel(: علاوه بر ساختار خطی فایل‌های دیجیتال، در نرم‌افزار 
فتوشاپ می‌توانید به تصویر جلوه‌های خطی و یا نقطه‌ای داد و ظاهر آن را خطی 
نمود، در واقع وقتی روی تصاویر خطی شده با ذره‌بین زوم می‌کنید باز می‌بینید 
که ساختار آنها پیکسل است. این گونه جلوه ها را نباید با ساختار خطی شکل گیری 

تصاویر اشتباه گرفت.

با نکته بنابراین  است  علوم  همۀ  گستردگی  به  دیجیتال  تصاویر  از  استفاده  حوزۀ 
دو  برای  متفاوتی  کاربردهای  می توانید  علمی  مختلف  حیطه های  در  جستجو 

دسته بندی کلی تصاویر دیجیتال یعنی )Vector( و )Raster( بیابید.

 گام اول: ابتدا از مسیر )Mode →  Gray scale( تصویر خود را سیاه و سفید 
کنید.

گـزینه  بـاز شده  پنجرۀ  از   mode → Bitmap از مسیر  سپس    گـام دوم: 
Halftone screen را انتخاب کنید. 

 گام سوم: سپس از پنجرۀ باز شدة Halftone screen تنظیمات shape و یا 
شکلی که پیکسل‌های تصویر به آن شکل چیده می‌شوند، را روی گزینه Line قرار 
دهید. در نهایت خواهید دید تصویر شما با توجه به تعداد خط و زاویه خطوطی که 

در پنجره Halftone انتخاب كرده‌اید تبدیل به تصویر خطی شود.

از نکته بعد  که  است  این  تصاویر  روی  بر  خطی  جلوه‌های  اعمال  روش‌های  از  یکی 
باز نمودن تصاویر در نرم‌افزار مسیر زیر را طی نمایید.

تصویر اصلی                                                              تصویر خاکستری
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Halftone Screen پنجرۀ 

Halftone Screen از پنجره line تصویر بعد از اعمال حالت

  line مراحل بیت مپ کردن تصاویر افکت 
 گام اول: در پنجرة Bitmap که توضیح داده شد در بخش Method گزینه 
تصویر  یک  خاکستری‌های  حذف  با  که  دارد  وجود  درصد   ۵۰  threshold
سیاه و سفید آن را به سیاه و سفید خالص تبدیل می‌کند. threshold برای تهیه 

تصاویر سیلوئت برای پس زمینه‌ها مفید است.
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 گام دوم: از مسیر زیر می‌توان این جلوة تصویری را با کنترل بیشتری بر روی 
تصاویر رنگی اعمال نمود.

Image →  Adjustments  →  threshold

پیشنهاد می‌شود هنرجويان چند 
تصویر دیجیتال مانند درختان و 
باز كرده  نرم‌افزار  در  را  صخره‌ها 
آنها،  نمودن  سیلوئت  از  بعد  و 
فانتزی  فضای  یک  تلفیقشان  از 

خلق كنند.

threshold تصویر اصلی قبل از اعمال فیلتر

مقدار threshold 60 درصد

مقدار threshold  100 درصد
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کیفیت تصاویر دیجیتال
دیجیتال  تصویر  یک  کیفیت  بر  که  کتاب  متن  در  شده  مطرح  عوامل  بر  علاوه 
یا  مؤثر هستند، کیفیت و حساسیت سخت افزارهایی مانند دستگاه‌های اسکنر و 

دوربین‌های عکاسی دیجیتال، نیز در کیفیت تصویر ایجاد شده مؤثرند.

ایجاد صفحه جدید، فرمت‌ها و مودها  
 Art board یکی از امکانات جدید فتوشاپ گزینه CC2015 بعد از آخرین آپدیت
 Art board ابزار Move و اضافه بر آن زیر مجموعه ابزار new است. در پنجرۀ

tool نیز برای ویرایش آرت‌برُد گنجانده شده است.
و  تبدیل می‌کند  انجام کار  برای  بوم  به یک  را  واقع صفحة جدید  این گزینه در 

داخل  را  فایل  چندین  داشتن  امکان 
یک سند به شما می‌دهد. عملاً‌  اندازة 
ابتدا  در  ساخته‌اید  که  فایل جدیدی 
و  جابه‌جایی  با  ولی  می‌شود  تعیین 
یا افزودن آرت‌بردهای متعدد به یک 
سند، ابعاد سند اتوماتیک متناسب با 
تغییر  سند  داخل  آرت‌بردها  جایگاه 

می‌یابد.
هرگاه  سند  یک  لایه‌های  پنجرة  در 
یک آرت‌برد اضافه می‌شود لایه‌ای به 
نام آرت‌برد اضافه می‌گردد که داخل 
آن، لایه‌های مربوط به آن طرح وجود 

دارند. 

نکته امروزه با تنظیمات مختلف دوربین‌های دیجیتال می‌توان تصاویری با کیفیت‌های 
مطلوب برداشت نمود.

art board تصویر گزینه
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نکاتی در مورد آرت‌برد  
1  به راحتی می‌توان با ابزار art board tool تعداد زیاد فایل جدید ایجاد نمود و 

یا ویرایش جدید از فایل‌های موجود داشت.
اینکه به  ابزار آرت‌برد به راحتی قابل تغییرات است؛ بدون  با  ابعاد آرت‌بردها    2
ابتدا گزینه آرت‌برد آن  پنجره Image size رجوع کنید. در واقع سندی که در 

فعال می شود، ابعادش متغیر است.
قابل کپی در آرت‌بردهای جدید هستند. کافی است  به راحتی  لایه‌های سند   3

با ابزار move )جابه‌جایی( آن لایه را از یک آرت‌برد به آرت‌برد دیگر درک نمود.
نام  و  4  هنگامی که روی یک آرت‌برد در داخل یک سند راست کلیک کنید 
یکی از آرت‌بردها را انتخاب کنید؛ نرم افزار به صورت اتوماتیک، فول اسکرینِ )تمام 
صفحۀ(، آن آرت‌برد را نشان می‌دهد و با استفاده از دکمة اسپیس کی‌برد و راست 
کلیک شما به سرعت می‌توانید بین آرت‌بردها سويیچ کنید و در داخل هرکدام که 

خواستید اعمال دلخواه را انجام دهید.
5  به علت رنگ خاکستری فضای دسکتاپ و جدا بودن آرت‌بردها از همدیگر شما 
می‌توانید ویرایش های مختلف از یک فایل را داخل یک سند، مرور کنید و عملًا 
خاکستری دسکتاپ تفکیک آرت‌بردها را برعهده دارد، بنابراین می‌توان مثلًا چند 
نوع رنگ‌بندی از یک فضا را داخل چند آرت‌برد ولی داخل یک سند داشت و با 

هم مقایسه نمود.

دستورهای نرم‌افزار و کاربرد پنجره‌ها )لایه‌ها، قلم‌ها، پالت( 
Quick selection tool یکی از ابزار مهم برای انتخاب سریع، این ابزار است. ابزار 
انتخاب سریع، برای جدا کردن بخشی از یک تصویر از پس زمینه‌اش بسیار مفید 

است.
ابزار  همانند  نظر،  مورد  محیط‌های  روی  بر  ابـزار  درگ‌کـردن  بـا  است  کـافی 
magic wand tool )کمند جادویی( محیط را انتخاب نمود. مکانیزم عملکرد این 
ابزار به گونه‌ای است که پیکسل‌های هم رنگ که مرز مشخصی با پیکسل‌های دیگر 
دارند انتخاب می‌کند؛ برای همین در انتخاب رنگ های تخت که پیکسل‌های مشابه 

زیادی دارند این ابزار بهترین عملکرد را دارد. 
استفاده می‌کنیم  انتخاب سریع  ابزار  از  ابزار، هنگامی که  نوار  از گزینه‌های  یکی 

بین نکته خاکستری  فضای  سند،  یک  لایه‌ها(  نمودن  )یکی  نمودن  فلت  درصورت 
فایل  یک  صورت  به  اصلی  سند  و  می‌گردد  سفید  فضای  به  تبدیل  آرت‌بردها 

نمایش داده می شود.
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گزینه select and mask است که بسیار کاربردی و مهم است هنگام کلیک کردن 
روی این گزینه پنجرة تنظیمات پیشرفته quick selection )ابزار انتخاب سریع( 
باز می‌شود که می‌توان با استفاده از گزینه‌های متفاوت در پنجره باز شده با دقت 

بیشتری یک بخش تصویر را از پس زمینه‌اش جدا کرد.

select and mask تصویر پنجرۀ مربوط به گزینه

فعالیت ورزش  هنگام  مدرسه  حیاط  در  خود  دوستان  از  هنرجويان  می‌شود  پیشنهاد 
تصاویری تهیه كنند و سپس با این ابزار داخل فتوشاپ آن را از پس‌زمینه جدا 

کنند و در فضایی جدید مانند یک ورزشگاه مونتاژ كنند.

قلم‌ها  
همان طوری‌که می‌دانید با کلید میانبر B ابزار قلم فعال می‌شود و با راست کلیک 
می‌توان نوع قلم را انتخاب نمود. شکل قلمی که ما از پنجرۀ قلم‌ها انتخاب می‌کنیم 
به صورت نگاتیو نمایش داده می‌شود. یعنی اگر جایی از تصویر قلم انتخاب شده 
سفید رنگ باشد هنگام استفاده از قلم )با رنگ تیره(، اثری تیره بر روی صفحه 
قرمز  مثلًا  رنگ  یک  از  قلم   همان  رنگ  برای  هرگاه  بنابراین  می‌گذارد  به جای 
استفاده کنیم، همین نقطه که سفید دیده می‌شود اثری قرمز رنگ بر روی صفحه 

می‌گذارد.
بنابراین قلم‌هایی که در شکلشان )در پنجره انتخاب قلم (، پس زمینه تیره دارند. 

به جای تیرگی قلم)با رنگ تیره(، هیچ اثری بر روی صفحه نمی‌گذارد.
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در یک پس زمینه سیاه رنگ یک حباب سفید رنگ طراحی کنید.  و سپس از فعالیت
مسیرهای زیر آن را به شکل قلم تبدیل نمایید.

Ctrl + I یا کلید میانبر Image → Adjustments → Invert ابتدا
Edit → Define Brush preset    سپس

این نکته پراکندگی  و  کوچکی  بزرگی،  می‌توانید  قلم  پیشرفته  تنظیمات  بخش  در 
حباب‌ها را دست کاری نمود.

تصویر نوک قلم به شکل حبابقلم اینورت)وارونه( شده

کاربرد قلم تهیه شده )حباب( در فضاسازی
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رنگ و پالت‌های رنگی
در پنجرة شناور color picker گزینة color libraries وجود دارد که با کلیک 
کردن بر روی آن به کتابخانه‌ای گسترده از پالت‌های رنگی دسترسی میي‌ابید. این 
کتابخانه در اصل شامل گزیده‌ای از مهم‌ترین کتاب‌های رنگ هستند که در این 
کتاب‌ها خانواده‌های مختلف رنگ‌های هارمونیک را کدگذاری كرده و دسته‌بندی 

كرده‌اند.

کتابخانه کتاب‌های رنگ

نکته می‌توانید   color libraries پنجره  در   picker گزینة  روی  بر  کردن  کلیک  با 
مجدداً به پنجرة اصلی و پیش فرض color picker فتوشاپ برگردید.

نکته هر رنگی را از داخل یک کتاب رنگ انتخاب نمایید، در سمت راست آن پنجرة 
فایلتان  رنگی  مُد  به  توجه  با  را  رنگ  آن  دهنده  تشکیل  رنگ  تنُ‌های  درصد 

مشاهده خواهید نمود. 
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جعبه ابزار و کاربرد ابزارهای ویرایش  
)Move tool( ابزار جابه‌جایی: با استفاده از این ابزار می‌توان یک لایه و یا بخشی 

از یک لایه از سند را که انتخاب شده است، داخل سند فتوشاپ جابه‌جا نمود.
تنظیمات   )status bar( نوار وضعیت  ابزار در بخش  این  نمودن  فعال  در هنگام 
مختلفی فعال می‌گردند که امکان چیدمان  و توزیع لایه‌ها را در سطح سند )فایل(، 

برای شما پیشرفته‌تر و راحت‌تر می‌کند.

تنظیمات توزیع نمودن )distribution( و چیدمان لایه ها

لایه  آن  لایه،  داخل  کردن  کلیک  با  که  می‌کنید  تعیین  بخش  این  در  شما   :A
جابه‌جا شود و یا اینکه تعدادی از لایه‌ها که داخل یک گروه دسته‌بندی شده‌اند، 

هنگام درك کردن جابه‌جا شوند.

B: با فعال کردن این گزینه ۸ نقطه در حاشیة یک لایه نمایش داده می‌شود. با 
استفاده از این نقاط )کنترل کننده‌های تغییر فرم(، و به کمک موس می‌توان ابعاد 
یک لایه را به صورت دستی تغییر داد و با قرار دادن موس در نقاط گوشه لایه، آن 

لایه را چرخاند.

می‌توان در پنجرة لایه‌ها با پایین نگه داشتن دکمه ctrl کیبرد و کلیک کردن نکته
چند لایه را انتخاب نمود و سپس با کلید میانبر Ctrl +G و یا از مسیر زیر آنها 

را داخل یک گروه دسته‌بندی نمود. 
Layer → New →  Group from Layers
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نکته کنترل کننده‌ها،  این  باشند.  شده  )گروه(   Group همدیگر  با  لایه  چند  اگر   
انتهایی‌ترین پیکسل را در داخل گروه از چهار طرف به عنوان معیار لایه، برای 
تغییر ابعاد و یا چرخش درنظر می‌گیرد. پیکسل‌های انتهایی در هر سمت گروه، 

می تواند از لایه‌های مختلف داخل گروه باشد و حتماً از یک لایه نیست. 

C: اگر هنگام استفاده از ابزار جابه‌جایی دو لایه را انتخاب کنیم در این بخش ۶ 
با کلیک کردن بر روی  انتخاب شده، فعال می‌گردند که  حالت چیدمانِ دو لایۀ 
هر کدام از این ۶ حالت، لایه‌ها بر طبق حالت انتخاب شده چیده می‌شوند. برای 
مثال اگر حالت چیدمان نمودن لایه ها را با توجه به لبۀ بالایی لایه‌ها قرار دهیم، 

دو لایه مذکور با توجه به انتهایی‌ترین پیکسل لبة بالایی لایه ها چیده می‌شوند.

D: با انتخاب نمودن بیش از ۲ لایه برای توزیع و یا مرتب نمودن، ۶ حالت دیگر 
در نوار ابزار، فعال می‌گردند که برای Distribute یا توزیع و پخش کردن لایه‌ها 

در صفحه به کار می‌روند.

نکته به این چیدن Align کردن و یا بر طبق یک خط خاص مرتب کردن گفته می‌شود. 
این خط فرضی همواره موازی یکی از محورهای مختصات است حتی اگر لایه 

مورب باشد.

نکته این پخش کردن می‌تواند در دو حالت افقی و عمودی باشد که هر کدام از این 
دو حالت با توجه به لبه‌های )بالا، پایین، چپ، راست و وسط( لایه‌های انتخاب 

شده انجام می‌گرد. 

E: با فعال نمودن این گزینه Auto – Align layers  پنجره‌ای باز می‌شود که 
کاربردهای  و  است  مختلف  لایه‌های  در  تصویر  چند  چیدمان  مهم  پنجره‌های  از 

مختلفی دارد؛ نظیر:
کلاژ  به صورت  مجزا  عکس  چند  قالب  در  که  فضا  یک  مختلف  بخش‌های  الف( 

عکاسی شده باشند.
ب( تصاویری که به صورت مدور از دور یک استوانه نظیر یک ستون عکاسی شده 

باشند.
قالب چند  یا گود در  ج( بخش‌های مختلف یک فضا که داخل یک سطح مقعر 

عکس، عکاسی شده باشند.
د( بخش‌های مختلف یک فضا که به علت بزرگی با جابه‌جایی دوربین عکاسی، در 

قالب چند  عکس تهیه شده باشند.
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F: در این بخش از نوار وضعیت هنگام استفاده از ابزار جابه‌جایی )move( می‌توان 
تنظیمات یک فایل 3d نظیر فایل‌های 3dmax که داخل فتوشاپ باز شده است 

را دست کاری نمود.

 تمامی لایه‌هایی که شامل عکس‌های مختلف از یک فضا هستند. در این بخش 
به  بدهند، مشروط  را  واحد  تصویر  تشکیل یک  که  می‌شوند  گونه‌ای چیده  به 
اینکه در هر کدام از عکس‌هایی که از سطوح و یا اشیا کنار هم عکاسی شده اند، 

بخش مشترک )پیکسل‌های مشترک( وجود داشته باشد.

نکته

اسکن  هم  کنار  دیجیتال  تصویر  چند  قالب  در  نیز  را  بزرگ  تصاویر  می‌توان   
نمود و با این ابزار کنار هم چید و یک تصویر واحد به دست آورد. با توجه به 
رزولوشن بالای اسکنرها این امکان می‌تواند برای تهیه تصاویر یک تکه )واحد( 

با رزولوشن بالا بسیار مفید است.

نکته

 lens می‌توان با انتخاب گزینه‌های ،)Auto align layers( در تنظیمات این پنجره
از جابه جایی  که حاصل  آمده در حین عکاسی  به وجود  اعوجاج   ،correction

دوربین و لنز است را اصلاح نمود.

نکته

پانوراما فعالیت به صورت  فریم  چند  در  مسجد  یا  بازارچه  نظیر  سنتی  فضای  یک  از   
عکاسی نمایید و سپس با استفاده از پنجره Auto – Align layers آنها را کنار 

هم چیده و یک فضای واحد تهیه نمایید.

ابزار محو کردن )Blur tool(: با استفاده از این ابزار و زیر مجموعه‌اش می‌توان 
بخشی از یک تصویر را تا حدودی محو یا واضح نمود. 

امکانات  فیلتر،  منوی  داخل   blur مجموعه  فیلترهای  از  می‌توان  ابزار  این  از 
گسترده‌تری برای محوکردن یک تصویر و یا بخشی از آن تصویر استفاده نمود.

نکته

ابزار روشن کردن)Dodge tool(: با استفاده از این ابزار می‌توان بخشی از یک 
عکاسی  در  کاغذ  روی  به  نگاتیو  کپی کردن  مرحله  در  نوردهی  )مانند  را  تصویر 

آنالوگ(، روشن‌تر نمود.
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ابزار سوزاندن)Burn tool(: از زیر مجموعه ابزار Dodge، می‌توان از این ابزار 
برای ایجاد سایه و تیرگی در طراحی فضا استفاده نمود. به این صورت که با کلیک و 
یا درگ‌کردن برروی تنُ های رنگی و تیرگی و روشنی های تصویر، مناطق دلخواهی 

از تصویر را تیره تر نمود. 

فعالیت Dodge tool و  ابزارهای  با  نورپردازی  پیشنهاد می شود مراحل سایه پردازی و 
Burn tool را با هنرجویان تمرین نمایید.

لایة رنگ تخت در زیر لایۀ اصلی 

طراحی اولیه ربات
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 حالا می توانید با ابزار Dodge tool و کشیدن موس بر روی تصویر قبل که با 
Burn tool ایجاد كرده اید، نورها و درخشندگی لازم را به تصویر اضافه نمایید.

Dodge tool ایجاد روشنایی و درخشش توسط

  ابتدا یک لایة رنگ تخت زیر لایه خطی طرحتان ایجاد نمایید. مانند تصاویر بالا
  حالتِ لایۀ طراحی اولیه را از normal به multiply تغییر دهید. ) از گزینه های 

پنجرة لایه ها(
 سپس نقاط تیرۀ تصویر را با ابزار Burn tool با کشیدن موس بر روی لایه ای که حاوی 

رنگ تخت  است مشخص نمایید. مانند تصویر زیر:

Burn tool ایجاد تیرگی‌ها با سوزاندن تصویر توسط
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واحد يادگيري    6     : اجرای فضای دوبعدی دیجیتال  

قلم نوری   

اگرچه برای اجرای کارهای هنرجويی و تولیدات شخصی قطع متوسط قلم نوری 
به علت راحتی حمل و نقل، قطع بسیار مناسبی است، اما درصورتی که هزینة تهیة 
قطع بزرگ آن مهیا باشد، اندازة بزرگ به علت فضای گسترده‌تری که برای طراحی 

به ما می‌دهد مفیدتر خواهد بود.
بهترین نوع آن سینتیک کامپنیون )Cintiq Companion( است که شامل یک 
سیستم کامل به همراه سیستم عامل، مانیتور )صفحة تاچ( و قلم نوری است. که 
بر روی صفحۀ  نقاشی  بوم  بر روی یک  همانند کار  از آن دقیقاً  با استفاده  طراح 

مانیتور کار می‌کند و نیاز به رايانه در کنار تبلت و قلم نوری خود ندارد.
از مزایای آن دقت و کیفیت آن است و همچنین اینکه فضا یا شخصيت خلق شده 
مستقیماً زیر دست شماست بنابراین تمرکز و راحتی بیشتری در اجرای آن دارید 

اما از ایرادات آن گرانی قیمت و همچنین دشواری جابه‌جایی آن می‌باشد.

)Cintiq Companion( سینتیک کامپنیون

نکته  اغلب استودیودهای مجهز تولید پويانمايي به علت متغیر نبودن مکان تولیدشان 
در کامپنیون به جای قلم نوری‌های ساده‌تر و بدون lcd استفاده می‌کنند. 
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رنگ آمیزی، ایجاد سطوح تخت، بافت و سایه  
رنگ‌های سمبولیستی در پويانمايي

برای اینکه بر روی وجهه سمبولیستی یک رنگ تأکید شود مابقی رنگ‌های فضا 
معمولاً با خلوص پایین، مات‌‌تر و یا محوتر و کم رنگ‌تر به کار می‌روند در این گونه 
فضاها معمولاً رنگ‌های سمبولیستی خالص هستند و اغلب در فضاهایی با پس زمینه 

تیره به کار می‌روند برای اینکه با فضا کنتراست داشته باشند و بهتر دیده شوند.

سمبول  رنگ‌ها  نیز  گاهی 
با  اما  نیستند  نشانه  و 
در  آن  فراوان  تأکیدات 
یک  به  تبدیل  فیلم،  یک 
تماشاچی  ذهن  در  نشانه 
می‌توان  بنابراین  می‌گردند. 

سمبل سازی هم انجام داد.

نکته

کاربرد سمبولیستی رنگ در فیلم
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رنگ‌های اکسپرسیونیستی در پويانمايي  
خصوصیات  با  بودن  درگیر  به علت  فیلم  ژانرهای  اغلب  گفت  می‌توان  به جرأت 

روحی و روانی شخصیت‌هایشان، رگه‌هایی از اکسپرسیونیسم دارند. 
برتون  تیم  فیلم‌های  نمود.  اشاره  سورئالیستی  فیلم‌های  به  می‌توان  جمله  آن  از 
به صورت اکسپرسیونیستی  )فراواقعی( هستند که  فیلم‌های سورئالیستی  واقع  در 

فضاسازی شده‌اند.
و  امپرسیونیستی  اکسپرسیونیستی،  کاربردهای  از  ترکیبی  فیلم‌ها  اغلب  در 
و  می‌گیرد  قرار  استفاده  مورد  این سبک‌ها،  از  یکی  اولویت  با  رنگ  سمبولیستی 

سبکی که در اولویت است؛ گرایش کلی رنگ فیلم را تعیین می‌کند.

کاربرد اکسپرسیونیستی رنگ در فیلم
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رنگ‌های امپرسیونیستی در پويانمايي  
لی اوت این گونه آثار که اغلب برای کودکان ساخته می شود، دشوارتر از بقیه سبک ها 
است زیرا علاوه بر شخصیت‌ها، پس زمینه و فضا نیز با رنگ‌های شاد   و   مفرح طراحی 
می شوند؛ بنابراین تعدد رنگ در صحنه باعث دشواری لی اوت می گردد. برای همین 
بایستی از نکات اساسی لی اوت که مربوط به رنگ نیستند برای حل نمودن این 

مشکل استفاده نمود. 

کاربرد امپرسیونیستی رنگ در فیلم

 افراط در کاربرد سبکی رنگ باعث صدمه به فیلم می‌گردد؛ آن چنان که سبک 
بر  مخربی  تأثیر  که  می‌دهد  جهت  تغییر  زیر  گرایش‌های  سمت  به  آن  بصری 

جذابیت فیلم  نزد تماشاچیان دارد.

نکته

 کاربرد افراطی اکسپرسیونیستی رنگ، باعث سانتی مانتالیسم می‌گردد که نوعی 
مفهوم کلاس  اصطلاح،  این  عامیانه  کاربرد  در  است.  افراطی  مُدگرایی  و  پزُ دادن 

گذاشتن و فخرفروشی را نهفته است.
  امپرسیونیسم افراطی باعث ناتورالیستی شدن رنگ‌ها می‌شود که طبیعت‌گرایی 
افراطی در کاربرد رنگ است. آن چنان که تماشاچی با غرق شدن در زیبای افراطی 

رنگ از دنبال نمودن روایت  فیلم دور می افتد.
  سمبولیسم افراطی نیز باعث دکوراتیو و یا تزیینی شدن رنگ‌ها می‌شود که بیش 

از اندازه از سمبل دور می‌شود و دیگر نمی‌تواند به عنوان یک نشانه به کار رود.
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رنگ آمیزی همراه بافت و سایه 
 روش اول: سایه را به صورت یک لایه  می‌توان با ابزار قلم و یک رنگ تیره در 
لایه‌ای جداگانه ترسیم نمود. در این روش طراح بایستی تجربة زیادی در نورپردازی 

و سایه‌پردازی تصاویر با دست داشته باشد.
 روش دوم: روش دیگر برای ایجاد سایۀ اشکال بر روی سطوح دیگر این است که 
از لایة شکل یک کپی گرفت و آن را به یک لایة سیلوئت تبدیل کرد سپس غلظت 

)opacity( آن لایه را کم کرد.

کاربرد امپرسیونیستی رنگ در فیلم

در صورتی که کارگردان قصد القای سانتی مانتالیسم، ناتورالیسم و یا تزیین در 
اثرش را داشته باشد به عمد از رنگ‌ها به صورت افراطی استفاده می‌کند.

نکته

روش تبدیل یک لایه به سیلوئت )سایه( از مسیر زیر است:
)Ctrl+L کلید میانبر( Image → Adjustments → Levels

نکته

یا   High Light Output Level مقدار   ،Levels شده  باز  پنجرۀ  از  سپس 
درخشندگی خروجی را بر روی صفر قرار دهید. این مقدار در سمت راست پایین 

پنجره به صورت پیش فرض بر روی 255 قرار دارد.
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اکنون با یکی از فیلترهای گروه Blur اندکی لایۀ سایه را محو می‌کنیم و در نهایت 
با ترانسفورم نمودن لایۀ مذکور که به صورت یک لایۀ سایه درآمده است، آن را 

متناسب با جهت تابش نور تغییر جهت دهید.

بافت دهی به یک لایه  
می‌توان علاوه بر روش‌های مطرح شده در کتاب نظیر بلندینگ لایۀ بافت بر روی 
لایۀ زیری )تصویر( و یا استفاده از فیلترها، لایة بافت را مستقیماً در نرم‌افزار با ابزار 

قلم به وجود آورد.

ایجاد سایه با لایة سیلوئت

هنگام انتخاب قلم برای طراحی بافت می‌توان Mode آن را از نوار وضعیت بالای 
بافت‌های متنوعی  به حالت‌های دیگر تغییر داد و   Normal از حالت  دسکتاپ 

طراحی نمود.

نکته

 تنظیمات پیش رفتة قلم در پنجرۀ مطرح شده در کتاب درسی که با f5 فعال 
می‌شود به شما این امکان را می‌دهد که قلم را نیز بافت دار نمود و از این طریق 

بافت ایجاد نمود.

نکته


